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ABSTRAK 

 

Sistem perparitan adalah sistem penting yang berfungsi untuk mengawal air larian 

permukaan dan mengurangkan kesan buruk ke permukaan bumi. Sistem saliran yang 

betul adalah penting untuk menguruskan air larian permukaan. Gangguan alam 

semulajadi akibat kegagalan sistem perparitan akan mengakibatkan beberapa masalah 

seperti banjir, hakisan, bau dan bahaya kesihatan. Banjir mengakibatkan limpahan air 

akibat sistem perparitan yang tidak betul. Ia adalah masalah biasa yang membawa 

bahaya kepada kawasan kampung, bandar atau kawasan lain yang dihuni. Kawasan 

kajian dalam projek ini adalah di Bahagian 1, Bandar Baru Bangi. Kawasan kajian ini 

dipilih sebagai kawasan tadahan kerana kawasannya yang tidak lebih dari 80 hektar. 

Objektif kajian ini adalah untuk mengenalpasti corak saliran di kawasan tadahan kecil 

ini dan untuk menentukan masalah yang ada mengenai sistem perparitan di kawasan 

kajian. Kaedah yang terlibat boleh dibahagikan kepada dua, iaitu pengiraan dan 

simulasi. Dalam kaedah pengiraan, kaedah yang terlibat adalah kaedah Rasional dan 

Formula Manning. Kaedah Rasional digunakan untuk mengira pelepasan puncak 

manakala Formula Manning digunakan untuk kapasiti saliran. Perbandingan antara 

pelepasan air larian sub-tadahan dan pelepasan saliran mampu mengesan dan 

menyelesaikan saliran yang menghadapi masalah limpahan. Sementara itu, kaedah 

simulasi adalah dengan menggunakan perisian HEC-HMS dan HEC-RAS. Hasil dari 

simulasi menggunakan kapasiti 2 tahun, 5 tahun dan 10 tahun selang pengulangan 

purata menunjukkan bahawa ada beberapa saluran yang bermasalah di kawasan kajian 

yang memerlukan reka bentuk semula. 
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ABSTRACT 

 Drainage system is important systems which function to control surface runoff 

and decreasing the bad effect to earth surface. Proper drainage system is important to 

manage surface runoff while improper drainage system will causes some problem to 

environment such as flooding, erosion, odor and health hazard. Study area in this 

project is at Section 1, Bandar Baru Bangi. The objectives of this study case are to 

determine the drainage pattern, to estimate the maximum flow of the drainage system 

and to check the drainage capacity of 2 years ARI, 5 years ARI and 10 years ARI in the 

study area. The methods involved are the Average Rainfall Station, Rational Method 

and the Manning’s Formula. The Average Rainfall Method is used to identify the 

missing value in the rainfall data provided by Department of Irrigation and Drainage 

Malaysia. The Rational Method is used to calculate the peak discharge while the 

Manning’s Formula is used to determine the capacity of drainage. The result of this 

study is to justify whether the existing drain are still able to support the amount of 

rainfall intensity the design of the drainage can support the intensity of the rainfall. 
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CHAPTER 1 

 

 

INTRODUCTION 

1.1 General 

Drainage system has its own pattern which can be rectangular, parallel, trellis 

and dendritic. The pattern of the drainage may affect the flood prediction as different 

place may have different average rainfall thus suitable drainage pattern is needed to less 

likely to have lower percentage of flood. The local topography and geology surface also 

may affect the drainage pattern. The catchment area function as water basin to minimize 

the flow of water and to trap the sediment. 

This study is about drainage pattern and flow simulation and estimation on flood 

at Section 1, Bandar Baru Bangi, Hulu Langat, Selangor. It focused on drainage or open 

channel to flow water in case of rainfall. The drainage system in this area directly 

transfer to the nearest river to end the flow of the drainage. The urban area drainage 

uses the same concept as natural parts in flow but substitute it with lined drain, pipe, 

swale and inlet. Concrete drain and expected of stimulation flood in 2, 5 and 10 years 

Average Rainfall Intensity (ARI). 

Flow estimation is important to ensure that catchment area of drainage system is 

safe and can contain the water flow of the rainfall in its major and minor system design. 

Major and minor system design is depended on the area of drainage and its design 

criteria. 

1.2 Problem Statement 

Improper drainage system will cause some problem to environment. Disturbance 

of the natural due to drainage system failure will result in disaster and occurences such 

as flash flood, overflow, erosion, odors and health problem.  



2 

Some of occurrences of the flash flood have happened recently in our country 

which is in Kuala Lumpur and Pulau Pinang. The flash flood has made a lot of damage 

to the city, car and others electrical appliances. The flash flood in Pulau Pinang that 

happened in Georgetown started with a non-stop heavy rain that covered a few district 

or area of the town in flash flood. The heavy rain started at 2 pm give a rise of the water 

level as much as 0.3 metres that makes the low-lying areas flooded. The flooded areas 

that have been affected due to this heavy rain is Jalan P.Ramlee, Lebuh Carnavon, 

Lebuh Muntri, Lorong Kinta, Jalan Anson, Lebuh Kimverly, Lebuh Mcnair and a few 

more areas in Seberang Perai. Figure 1.1 shows the flash flood at occurred in Penang.  

(Yaakob, 2017) 

Recently, there was flash flood occur in the federal highway at Kuala Lumpur 

near the Mid Valley. It causes traffic jammed from Seputeh to Taman Desa and also in 

the main road around the Kuala Lumpur. This flash flood also affected the motorcycle 

user to cross the road as the water started to decrease 45 minute after the rain stopped. 

The Figure 1.2 shows the flash flood that occurred in the federal highway. (M Star, 

2016) 

It is important to decrease the occurrence of flood in a catchment area. Flash 

floods always occur in catchment area during heavy raining in long time period. Bigger 

catchment area will help to reduce the flow rate and decrease the percentage of flash 

flood to occur. 

Flash flood may occur if the design is not according to minor and major 

drainage system. In Malaysia, these guidelines are made available in the Urban 

Stormwater Management Manual for Malaysia(MSMA).  

This case study is to investigate drainage pattern system located at Section 1, 

Bandar Baru Bangi. There are many shape of drainage pattern that are being used in 

Malaysia such as parallel, dendritic, rectangular and trellis. The capacity of channel and 

pattern of the drainage system can affect the performance of drainage system. Thus, this 

study is focused on overflow problem and flash flood in a small catchment area. 
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Figure 1.1 Flash Flood In Penang 

 

 

Figure 1.2 Flash Flood at Federal Highway near Kuala Lumpur 

 

1.3 Objectives of the Study 

The objectives of this study are: 

 To determine type of drainage pattern in Section 1, Bandar Baru Bangi. 

 To estimate the maximum flow of the drainage system in 2 years, 5 years 

and 10 years ARI. 
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 To check the capacity of the drainage system using HEC-HMS and 

HEC-RAS. 

1.4 Scope of Work 

This study consists of a study on hydraulic design and drainage pattern at 

Section 1, Bandar Baru Bangi. Drainage pattern can be determined from the urban area 

and brief observation on flow in the study area. Section 1, Bandar Baru Bangi. 

It focused on concrete drain which largely used in urban area. Capacity of the 

existing drainage in the study area were analysed. The Rational Method because is used 

as it is suitable for small catchment area which is not exceeding 80 hectares. Whilst the 

Manning’s equation is also used to calculate the capacity of the drainage.  

1.5 Significant of Study 

Most of the small catchment in small urban area can be assumed to have small 

catchments area. Usually they do not have the exact rainfall data in order to estimate the 

peak flow rate or the rainfall data station is too far from the area. Information on the 

exact rainfall data for small area is not recorded because this process is time consuming. 

Unfortunately, most of drainage system in small catchments area always faced 

with some problems such as excess water and flash flood. The short terms period of rain 

gauge is not practical to get the exact rainfall data and the increase of rainfall station 

can increase the cost for the material and maintenance of rainfall station. 

This study attempted to estimate the peak flow rate by using rainfall data from 

the bigger catchments area in Kajang as Kajang is the nearest rainfall station to Section 

1, Bandar Baru Bangi. The results used the Rational Method as recommended by 

Department of Irrigation and Drainage Malaysian in Urban Stormwater Management 

Manual for Malaysia (MSMA). 

The main significant of this research is to study the drainage pattern at Section 

1, Bandar Baru Bangi and to understand flash flood prediction. The time travel of flow 

in each drain chosen might affect the flood of this area. This study also functions as a 

stormwater strategy planning in order to avoid flash flood. Hopefully this study will 

help to improve the drainage system in study area and in the catchment area. 



5 

CHAPTER 2 

 

 

LITERATURE REVIEW 

2.1 General 

Drainage system plays a major role in hydrological process. The main source of 

drainage flow is from rainfall. Thus, proper drainage system is vital to manage surface 

runoff, to prevent overflow and avoid unexpected disaster. 

Overflow of drainage is one of the drainage problems. Improper drainage design 

can lead to this problem and may have the drainage clogged which can lead to low flow 

rate of water. When the drainage system is failed, it can lead to disaster when there are 

heavy rain such as flood and flash flood that usually happens in urban area. 
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2.2 Hydrological Process  

 

Figure 2.1 Hydrological Cycle  

Source: (Guidelines) 

From the Figure 2.1, water can be found in all of physical phases that is liquid, 

gas and solid. It can also be found in Earth’s major environments which is atmosphere, 

seas or oceans and landmasses as water can readily move from one environment to 

another and can change from one phase to another in response to its environment which 

is dynamic in both space and time. The Earth’s system of repositories for the storage of 

water and the multitude of paths aiming the many repositories has been conceptualized 

as a cycle. The science of hydrology has not traditionally encompassed the entire 

hydrological cycle, but has been limited to the land portion of the cycle and its 

interactions with the oceans and atmosphere. 

 There are two basic equations that describe the hydrological cycle that 

also vital in describing the systems that are used to make measurements of its transient 

properties which is the equation of continuity of mass and the equation of continuity of 

energy. For example, one of equation that used the continuity of mass is 
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     2.1 

 

 where, Q = Discharge 

  A = Area of stream or canal 

  V = Velocity of stream or canal   

This formula is often used as the basis to determine the flow rate in a stream or 

canal. In this equation, Q is the instantaneous rate of flow through a cross-section of 

channel with area, A and average flow velocity, V. Flow rate or discharge could not be 

measured directly for stream of even a modest size. A cross-sectional area however can 

be measured by sampling its spatial dimensions and velocities can be sensed by the use 

of the current meters which can determine the rate of discharge of even the largest 

rivers of the world. (Halliday, Kouwen, Greppi, & Harsten, 2008) 

2.3  Rainfall 

Hydrologists often need to estimate the volume of rainfall over a catchment area 

and require an adequate number of measurements in order to assess the spatial 

variation. This may be achieved with a network of rain gauges alone, or by using 

additional information from remote sensing thus rainfall station is needed to take the 

reading of rainfall intensity within the area for the hydrologists to estimate and run a 

simulation of rainfall-runoff modelling. 

In general, estimates of areal precipitation will increase in accuracy as the 

rainfall station increases but a dense network is difficult to managed and it has high 

maintenance cost thus a number of general guidelines for gauge density have been 

produced. The broad guidelines for the minimum gauge density of precipitation which 

is one rainfall station per 25 km² for small mountainous islands and one rainfall station 

per 250 km² in other areas. (Halliday, Kouwen, Greppi, & Harsten, 2008) 

The frequency of heavy rainfall is of interest to the hydrologist for a number of 

reasons including the design of engineered structures such as bridges, culverts and flood 

alleviation schemes. The duration of the design storm rainfall that is selected will 

depend upon the design objectives. The critical storm duration may be different with the 
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stream in different size, it may take several days for the big stream or catchments area 

to flow but it may take few hours for the small and medium stream or catchments area 

to be full and will be flooded. In this case, it is important to design a drainage system 

that is fast responding impermeable urban catchments area (Mays, 2001).   

2.4 Catchment Area 

Catchment area or drainage basin, area drained by a stream or other body of 

water. The limit of a given catchment area are the heights of land-often called drainage 

divides, or watershed-separating it from neighbouring drainage systems. The amount of 

water reaching the river, reservoir or lake from its catchment area depends on the size 

of the area, the amount of precipitation and the loss through evaporation and through 

absorption by the earth or by the vegetation, absorption is greater when the soil or rock 

is permeable than when it is impermeable. A permeable layer over an impermeable 

layer may act as a natural reservoir, supplying the river or lake in very dry seasons. The 

catchment area is one of the primary considerations in the planning of a reservoir for 

water-supply purposes (Wurbs, 2002). 

The drainage basin acts like a funnel – collecting all the water within the area 

covered by the basin and channelling it into a waterway. Each drainage basin is 

separated topographically from adjacent basins by a ridge, hill or mountain, which is 

known as a water divide. Other terms that can be used to describe the same concept are 

catchments, catchment area, catchment basin, drainage area, river basin and water 

basin. 

2.4.1 The Importance of Catchment Area 

In hydrology, for studying the movement of water within the hydrological cycle, 

the main focus for it is the drainage basin because the majority of water that discharges 

from the basin outlet originated as precipitation falling on the basin. A portion of the 

water that enters the groundwater system beneath the drainage basin may flow towards 

the outlet of another drainage basin because groundwater flow directions do not always 

match those of their overlying drainage network. Measurement of the discharge of 

water from a basin may be made by a stream gauge located at the basin’s outlet.  



9 

Rain gauge data is used to measure total precipitation over a drainage basin, and 

there are different ways to interpret that data. If the gauges are many and evenly 

distributed over an area of uniform precipitation, using the arithmetic mean method will 

give good results. In the Thiessen polygon with the rain gauge in the middle of each 

polygon assumed to be representative for the rainfall on the area of land included in its 

polygon. These polygons are made by drawing lines between gauges, and then making 

perpendicular bisectors of those lines form the polygons. The isohyetal method involves 

contours of equal precipitation are drawn over the gauges on a map. Calculating the 

area between these curves and adding up the volume of water is time consuming 

(Gribbin, 1997). 

 Drainage basins are important elements to consider also in ecology. As water 

flows over the ground and along rivers it can pick up nutrients, sediment and pollutants. 

Like the water, they get transported towards the outlet of the basin and can affect the 

ecological processes along the way as well as on the receiving water source as shown in 

Figure 2.2. 

Modern usage of artificial fertilizers, containing nitrogen, phosphorus and 

potassium, has affected the mouths of watersheds. The minerals will be carried by the 

watershed to the mouth and accumulate there, disturbing the natural mineral balance. 
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Figure 2.2 Catchment Area 

Source: (Guidelines) 

2.5  Drainage System and Pattern 

Drainage is the process by which surface water, waste or any other type of 

liquid matter is channelled or carried away. A drain is the means by which this process 

takes place. Drainage will be referring to open channel drainage. An adequately 

designed drainage system is important to the successful development of any develop are 

but the heavy rainfall which occurs frequently will make drainage design seem difficult. 

In order to achieve success in drainage design, it should be carried out by engineers 

experienced in hydrological design (Sumramanya, 1995). 

Drainage system is an important system that control surface runoff and reduces 

erosion. Water is the cause of soil erosion. Excess infiltration into ground surface 

decreases the shear strength of soil. Thus, proper drainage system is important to 

manage surface runoff. 

Meanwhile, a drainage pattern is a stream system achieves a particular drainage 

pattern to its network of stream channels and tributaries as determined by local geologic 

factors. Drainage patterns or nets are classified on the basis of their forms and textures. 

Their shapes or patterns develop in response to the local topography and subsurface 

geology. Drainage channels develop where surface runoff is enhanced and earth 

materials provide the least resistance to erosion. 
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The texture is governed by soil infiltration and the volume of water available in 

a given period of time to enter the surface. If the soil has only a moderate infiltration 

capacity and a small amount of precipitation strikes the surface over a given period of 

time, the water will likely soak in rather than evaporate away. If a large amount of 

water strikes the surface then more water will evaporate, soaks into the surface, or 

ponds on level ground. On sloping surfaces this excess water will runoff. Fewer 

drainage channels will develop where the surface is flat and the soil infiltration is high 

because the water will soak into the surface. The fewer number of channels, the coarser 

will be the drainage pattern (Chow, 1973). 

2.5.1 Dendritic Drainage Pattern 

A dendritic drainage pattern is the most common form and looks like the 

branching pattern of tree roots. It develops in regions underlain by homogeneous 

material that is, the subsurface geology has a similar resistance to weathering so there is 

no apparent control over the direction the tributaries take. A tributary joining larger 

streams at acute angle (Livesly, 1960). Figure 2.3 shows a dendritic drainage pattern on 

its shape and topography view. 

The dendritic drainage pattern is so common that it’s usually develop in the area 

of unconsolidated material beneath the stream that can be eroded quite easily in all 

direction. The examples of unconsolidated material are granite, gneiss, volcanic rock 

and sedimentary rock that has not been folded. (In, 2018) 
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Figure 2.3 Dendritic Drainage Pattern Source: (Science, 2016) 

2.5.2 Parallel Drainage Pattern 

Parallel drainage patterns form where there is a pronounced slope to the surface. 

A parallel pattern also develops in regions of parallel, elongate landforms like 

outcropping resistant rock bands. Tributary streams tend to stretch out in a parallel-like 

fashion following the slope of the surface. A parallel pattern sometimes indicates the 

presence of a major fault that cuts across an area of steeply folded bedrock. All forms of 

transitions can occur between parallel, dendritic and trellis patterns (Livesly, 1960). 

Figure 2.4 shows a parallel drainage pattern shapes. 

Normally, parallel pattern is caused by steep slopes with some relief. More of it, 

the streams are usually swift and straight with very few tributaries and all flow in the 

same direction. Parallel drainage patterns form where there is a pronounced slope to the 

surface. A parallel pattern also develops in regions of parallel, elongate landforms like 

outcropping resistant rock bands (In, 2018) . 
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Figure 2.4 Parallel Drainage Pattern  

Source: (Geologycafe, 2016) 

2.5.3 Trellis Drainage Pattern 

Trellis drainage patterns look similar to their namesake, the common garden 

trellis. Trellis drainage develops in folded topography like that found in the 

Appalachian Mountains of North America. Down-turned folds called synclines form 

valleys in which resides the main channel of the stream. Short tributary streams enter 

the main channel at sharp angles as they run down sides of parallel ridges called 

anticlines. Tributaries join the main stream at nearly right angles(Maidment, 1993). 

Figure 2.5 shows a trellis drainage pattern on its shape and topography view. 

Trellis patterns are formed by the network of tributaries and master consequent 

streams which follow the regional slope and are well adjusted to the geological 

structures. This pattern are developed in the area of simple folds characterised by 

parallel anticlinal ridges alternated by synclinal valleys(Raut., 2017). 

 



14 

 

Figure 2.5 Trellis Drainage Pattern  

Source: (Science, 2016) 

2.5.4 Rectangular Drainage Pattern 

The rectangular drainage pattern is found in regions that have undergone 

faulting. Streams follow the path of least resistance and thus are concentrated in places 

were exposed rock is the weakest. Movement of the surface due to faulting off-sets the 

direction of the stream. As a result, the tributary streams make shape bends and enter 

the main stream at high angles (Akan, 2006). Figure 2.6 shows a rectangular drainage 

pattern on its shape. 

Rectangular drainage pattern is formed when the main streams and their 

tributaries display many right-angle bends and exhibit sections of approximately the 

same length. In this pattern, it is indicative of streams following prominent fault or joint 

systems that break the rocks into rectangular blocks. (Raut., 2017) 
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Figure 2.6 Rectangular Drainage Pattern  

Source: (Science, 2016) 

2.5.5 Radial Drainage Pattern 

The radial drainage pattern develops around a central elevated point. This 

pattern is common to such conically shaped features as volcanoes. The tributary streams 

extend the head ward reaches upslope toward the top of the volcano (Killgore, 2009). 

Figure 2.7 shows a radial drainage pattern on its shape and topography view. 

This pattern of drainage usually can be found in volcanoes in which consequent 

streams radiate or diverge outward, like the spokes of a wheel from a high central area. 

Usually, on the site of this pattern a major collector stream is found in a curvilinear 

alignment around the bottom of the elevated topographic feature. Radial drainage 

pattern us best developed on the slopes of a young domal structure, a volcanic cone or 

isolated hills. (NRCS, 2016) 
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Figure 2.7 Radial Drainage Pattern  

Source: (Science, 2016) 

2.5.6 Centripetal Drainage Pattern 

The centripetal drainage pattern is just the opposite of the radial as streams flow 

toward a central depression. This pattern is typical in the western and southwestern 

portions of United States where basins exhibit interior drainage. During wetter portions 

of the year, these streams feed ephemeral lakes, which evaporate away during dry 

periods. Salt flats are created in these dry lake beds as salt dissolved in the lake water 

precipitates out of solution and is left behind when the water evaporates away (Cotton, 

2009). Figure 2.8 shows a centripetal drainage pattern. 

Centripetal drainage patterns are produced where drainage converges on a single 

outlet or sink, as in some craters, eroded structural domes with weak cores, parts of 

some limestone country and enclosed desert depressions. (Britannica) 
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Figure 2.8 Centripetal Drainage Pattern  

Source: (Flexiprep, 2015) 

2.5.7 Deranged Drainage Pattern 

Deranged or contorted patterns develop from the disruption of a pre-existing 

drainage pattern. Figure 2.3 began as a dendritic pattern but was altered when overrun 

by glacier. After receding, the glacier left behind fine grain material that forms wetlands 

and deposits that damned the stream to impound a small lake. The tributary streams 

appear significantly more contorted than they were prior to glaciation. 

The patterns described above are accordant, or correlated with the structure and 

relief over which they flow. Those streams that are discordant with the rocks over 

which they floe are either antecedent or superimposed. For instance, antecedent streams 

flowed across bedrock structures prior to uplift. Slow mountain building permitted 

stream erosion to keep pace with uplift. Streams in portions of the Appalachian 

Mountains have formed in weaker rock that through time has eroded away. These 

streams appear to be superimposed over the rock layers that they presently flow over. 

The Cumberland Gap is a famous water gap formed in this way as it cuts through the 

folds of the Appalachians (Nalluri, 1988). Figure 2.9 shows a deranged drainage pattern 

shapes. 
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Figure 2.9 Deranged Drainage Pattern  

Source: (Geologycafe, 2016) 

2.6 Major and Minor System Concept 

The major system is expected to protect the community from the consequences 

of large, reasonably rare events, which could cause severe flood damage, injury and 

even loss of life. Major system required more space to use as the drainage is more 

bigger and has a deeper depth compare to the minor system. Usually the major system 

is located in a cities area which have a big area, a high density of resident and low-lying 

area. 

On the other hand, the minor system is designed to convey runoff from a minor 

storm, which occurs relatively frequently and would otherwise cause inconvenience 

nuisance flooding. The minor system typically comprises a network of kerbs, gutters, 

inlets, open drains and pipes. The appropriate magnitude of the minor design storm 

depends on a wide variety of factors including community attitudes, technical 

considerations, cost and other economic factors. Due to the wide variation in these 

factors between different locations, it is not surprising that the recommended magnitude 

of the minor design flood also varies. Values typically range between 2 years and 10 

years Average Rainfall Intensity (ARI). 

Ideally, the choice of design standard for both major and minor storms should be 

made by economic analysis, taking into account the tangible and intangible costs and 
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benefits of different levels of protection. This type of analysis is comparable to the 

economic cost-benefit analyses sometimes undertaken for flood mitigation projects. It is 

however, quite impractical to suggest that this kind of benefit-cost analysis should be 

done for every single project, especially small projects. (MSMA, 2012)                          

Many overseas countries have adopted a 100 years ARI standard for the major 

design storm. Recently, this standard has been extended to urban drainage as well as to 

flooding caused by rivers. While a case can be made out for varying the major design 

storm standard because of technical, social and economic considerations, an equally 

strong case can be made for a uniform standard on the grounds of social equity. The 

major design storm standard recommended is 50 years ARI, except for major city 

centres where it is 100 years ARI (MSMA, 2000). Table 2.1 shows the benefits between 

of major and minor systems. 

Table 2.1 Community Benefits of Major and Minor Systems (MSMA, 2000) 

MAJOR SYSTEM MINOR SYSTEM 

Reduced injury and loss of life 

 

Improved aesthetics 

 

Reduced disruption to normal business 

activities 

 

Reduction in minor traffic accidents 

Reduced damage to infrastructure services 

 

Reduced health hazards (mosquitoes, flies) 

Reduced emergency services costs 

 

Reduced personal inconvenience 

Reduced flood damage 

 

Reduced roadway maintenance 

Reduced loss of production 

 

Minimize disturbance to existing drainage 

pattern 

Reduced clean-up costs 

 

Control flooding of property, structure and 

roadways 

Increased feeling of security 

 

Maintain sustainable drainage system  

Increased land values 

 

Minimize environmental impacts 

Improved aesthetics and recreational 

opportunities 

Improve in organizing catchment area of water 

flow 

 

2.7 MASMA 

The Stormwater Management Manual is prepared by Department of Irrigation 

and Drainage Malaysia (DID) to replace the first manual which is it meant for 

Australia. It is comprehensive, taking into consideration the present problems facing by 

the nation such as flash flood, river pollution, soil erosion, development in the 
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highlands and lowlands and so on. Latest development based on control at source 

approach has also been documented. This manual has also been reviewed by various 

agencies, organizations and foreign experts. Where applicable, their views are taken 

into consideration in preparing the final document. 

The function is to provide guidance to all regulators, planners and designers 

who are involved in stormwater management. It identifies a new direction for 

stormwater management in urban areas in Malaysia. It also can help to reduce the 

occurrences or disaster that happen in Malaysia. 

Stormwater management within a catchment is often undertaken by a number of 

organizations. The challenge is to ensure that the administration of the planning, design 

and maintenance of stormwater management systems is consistent across the relevant 

local, state, and federal authorities and the professions of planning, environmental and 

civil engineering, and landscape architecture. 

The objectives of MSMA are to: 

 Ensure the safety of the public. 

 Control nuisance flooding, flash flood and provide for the safe passage 

of less frequent and larger flood events 

 Protect property 

 Stabilize the landform and control erosion 

 Optimize the land available for urban development 

 Minimize the environmental impact of urban runoff on water quality 

 Enhance the urban landscape 

2.7.1 Rational Method 

The most frequently needed result in surface water modelling is an estimate of 

peak discharge resulting from a storm. It is the simplest approach to predicting that 

discharge is to use the Rational Method or equation. This method was developed for 
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small watersheds, usually undergoing urbanization (i.e. 40 hectares or 100 acres, can 

apply less accurately up to 400 hectares or 1000 acres). It is quite popular because it 

specifically addresses those parameters most subject to change during urbanization. 

Rational Method equations are: 

  
   

   
 

2.2 

 

where,  

Q = Peak discharge (m³/s) 

C = Rational method runoff coefficient 

I = Rainfall intensity (mm/hr) 

A = Drainage area (hectare) 

 

Assumption used in Rational Method 

 Flows occur when the sub – catchment contribute to the flow of channel. 

 Rainfall intensity was to be same all over the catchment area. 

 Rainfall intensity was uniform with the rainfall data which was same 

with time of concentration. 

 Average Recurrence Interval (ARI) in calculation of peak flow was 

similar as the rainfall intensity, for example, rainfall intensity for 5 years 

ARI will produce 5 years peak flow ARI. 

The Rational Method runoff coefficient (C) is a function of the soil type and 

drainage basin slope. Figure 2.10 shown runoff coefficient for minor and major 

systems. 
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Figure 2.10 Runoff Coefficient for Major and Minor Systems (MSMA, 2012) 

The Rainfall Intensity (I) is typically found from Intensity/Duration/Frequency 

curves for rainfall events in the geographical region of interest. The duration is usually 

equivalent to the time of concentration of the drainage area. The storm frequency is 

typically stated by local authorities depending on the impact of the development. A 10-

year, 25-year, 50-year, or even 100-year storm frequency may be specified (MSMA, 

2000). 

2.7.2 Manning’s Equation 

Under the assumption of uniform flow condition the bottom slope is the same as 

the slope of the energy grade line and the water surface slope. The Manning’s, n is a 

coefficient which represents the roughness or friction applied to the flow by the 

channel. Manning’s n values are often selected from the channel material, but can be 

back calculated from field measurements. In many flow conditions the selection of a 

Manning’s roughness coefficient can greatly affect computational results. 
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2.3 

where, 

 Q  = Design discharge for open channel (m³/s) 

 n  = Manning roughness coefficient 

 A = Cross sectional area of open channel 

 R = Hydraulic Radius (m) 

= Cross sectional area divided by wetted perimeter = A/P 

 P = Wetted perimeter 

 S = Channel slope (m/m) 

The Manning Equation is the most commonly used equation to analyse open 

channel flows. It is a semi-empirical equation for simulating water flows in channels 

and culverts where the water is open to the atmosphere. The channel can be any shape – 

circular, rectangular and triangular. The units in the Manning equation appear to be 

inconsistent; however, the value n has hidden units in it to make the equation consistent. 

The Manning Equation was developed for uniform steady state flow (MSMA, 2000).  

2.7.3 Structural and Composite Drain 

A composite drain is the combination of lined drain and grassed section that has 

been provided in the locations subject to dry-weather base flows which flow which 

otherwise damage and eroded the invert of the drain. Lined drain could be constructed 

from materials proven to be steady, durable and have satisfactory jointing systems. 

Some of the materials that can be used to construct lined open drains as follow: 

 Plain concrete 

 Reinforced concrete 

 Stone pitching 



24 

 Plastered brickwork  

 Precast masonry blocks 

According to Chapter 14 in MSMA here are also some other requirements and 

design consideration to build composite drain such as drainage area, roadway reserves, 

privately owned lots and public open space. In drainage area, the needs to determine the 

drainage types is based on space availability, site suitability, environment conditions 

and also maintenance advantages and disadvantages. Standardised locations for lined 

drains are provided to limit the negotiations needed when other services are involved. 

Meanwhile, the roadway reserves of the outer edge of lined drain should be located at 

least 0.5m from the property boundary on the high side of road reserves. 

Next, municipal lined drains should not be located within privately owned 

properties where lined are to be provided at the side or rear of private properties, they 

should be placed within a separate drainage reserve in accordance. For the public open 

space, the drains should be located as close as possible to the nearest property boundary 

with due consideration for public safety. (MSMA, 2012) 

As for the design criteria of drains, the maximum depth of drain without the 

protective covering is 0.6m and with the cover is 1.2m. The depth of an open drain must 

also include a minimum freeboard of 50 mm above the design storm water level in the 

minor drain. The average of flow velocity for the minor drain is between 0.6 m/s to 2.0 

m/s. If the flow velocity is less than 0.6 m/s, it will cause sediment harder to flow and if 

the flow velocity is more than 2.0 m/s, the water will erode the drain and the drain will 

be damaged. (MSMA, 2012) 

2.8 Software 

There are few software available in the market to analyse drainage capacity in 

the urban areas. Some of the software is free software that can be downloaded from the 

internet. The software that are normally used in the drainage in urban areas is 

InfoWorks CS, Mike, XPSwmm and Hec-Ras. The software can be run directly to 

analyse and run simulation of the drainage system except for Hec-Ras because Hc-Ras 

need the hydrograph data that can be obtain from Hec-HMS. 
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2.8.1 InfoWorks CS 

Under the InfoWorks there are several suite products can that can be use in the 

whole water cycle, from supply and distribution, urban drainage and wastewater 

management through to river modelling. The software can generate models of 

hydraulics flow with high accuracy which can be produce with source data and 

hydraulics modelling that available in the software. The suite products of InfoWorks is 

InfoWorks CS, InfoWorks WS and InfoWorks RS (Wallingford, 2007). 

The InfoWorks CS is being used to manage urban drainage network models, 

containing network and hydraulic data. The behaviour of the network can be simulated 

after the model have been created but under a range of the conditions. InfoWorks CS 

can do the modelled of both above and below ground hydraulics plus the InfoWorks CS 

also can change between a pressurised and free surface flow conditions. 

 The data that need to used can be imported from a wide range of sources 

or created within the system source and model data, then the data that were being 

inserted can be stored in a master database and may be edited at any time. The 

InfoWorks can also provide audit trail of the modelling process from the source data for 

the final outputs. Geographical plan views, sectional views, long sections, data grids 

and time-varying graphs is available in the software for the user to view it. The viewing 

of the data can also be accessed when view any graphical or geographical view. The 

software also full completed with animated presentation of the results that has been gain 

that are easily to understand. The software also contains extensive diagnostics error 

checking and warning, and rapid access to full on-line documentation. (Wallingford, 

2007) 

2.8.2 MIKE 

Mike Urban Water Distribution(WD) is a GIS-based software system for the 

data management and modelling of flows, pressure distributions and water quality of 

pressurised water distribution systems. It provides a complete working environment for 

sophisticated analyses in water supply engineering. MIKE URBAN WD covers 

modelling of surface runoff, flows, water quality and sediment transport. The software 

is the urban water modelling software of choice when the important parameters for 
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model selection are stability, work flow, openness, flexibility, GIS integration and 

physical soundness. (Mike, 2017) 

There were many courses of topic that MIKE URBAN WD covers such as: 

 Overview of MIKE URBAN and the project concept 

 GIS functionalities: Selection, layers, symbology, labelling 

 Manual and graphic data input and editing options 

 Essentials of data import/export functionality 

 Tools for facilitating the modelling process 

 Demand distribution and allocation 

 Running the simulations and presenting the results 

 Hydraulic analysis (steady state and extended period simulation) 

 Water quality analysis (chemical concentration, water age and source 

tracing) 

 Control rules (simple and rule based) and fire flow analysis 

 Hands-on exercise 

MIKE is a part of DHI which the global organisation dedicated to solving 

challenges in water environments worldwide. MIKE has been used by many engineers 

as the software can deliver technology and tools that can help to optimal the solutions to 

water challenges. (Mike, 2017) 

2.8.3 XPSwmm 

XPSwmm is a fully dynamic hydraulic and hydrologic modelling software that 

combines 1D calculations for upstream to downstream flow with 2D overland flow 

calculations so that you can see what truly happens to your stormwater system, foul 

water system or floodplain when waters flow, populations increase or catastrophic 
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events hit. XPSwmm allows integrated analysis of flow, pollutant transport and 

sustainable design measures in engineered and natural systems including ponds, rivers, 

lakes, overland floodplains and the interaction with groundwater. (Ray, 2017) 

XPSwmm gives you the power to analyse and predict potential flood extends, 

depth and velocity and accurately model the interaction of surface and underground 

systems in an integrated 1D/2D modelling environment. The software can also be 

effectively used to simulate and analyse tidal surges, dam breaks and breaches on sewer 

networks. 

There are three most used application in the XPSwmm which is being used in 

hydrological cycle which are floodplain management and river systems, foul water and 

combined sewer systems and stormwater management. In these three major application, 

there are subs under them, floodplain management and river systems covers all aspects 

in flood and river system such as: 

 1D/2D river hydraulic performance 

 Floodplain mapping and flood hazard analysis 

 Evacuation route planning 

 Interior Drainage (levee-protected areas) analysis 

 Culvert and bridge hydraulics 

 Fully coupled urban and river drainage systems 

As for the foul water and combined sewer systems covers such as 

 Capacity analysis and collection system optimisation 

 CSO and SSO mitigation planning 

 RDII (rainfall-derived infiltration and inflow) studies 

 Real-time control system performance 

 Water quality analysis 
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As for the stormwater management covers such as 

 Stormwater master plans 

 Major/minor or dual-drainage systems 

 Watershed management master plans 

 Hydromodification 

 Contaminant & sediment loading and transport 

 Pollutant removal 

 1D/2D urban flooding  

 Detention pond optimisation 

 Interconnected pond routing  

 Stormwater system design 

 WSUD and BMP analysis 

XPSwmm equips the engineers with completed accurate analysis and reporting 

the results that can be view in nearly any format and can be fully customize. Next, can 

compare the results with various of scenarios including 2D layers. More than that, 

XPSwmm has been installed with GIS and CAD which can easily be used in XPSwmm 

when needed. Lastly, XPSwmm can export or import from SWMM5 model. (Ray, 

2017) 

2.8.4 HEC-HMS 

The Hydrologic Modelling System (HEC-HMS) is designed to simulate the 

complete hydrologic process of watershed systems. HEC-HMS can include many 

traditional hydrologic analysis procedures such as event infiltration, unit hydrographs 

and hydrologic routing. It is also includes procedures necessary for continuous 

simulation including evapo-transpiration, snowmelt and soil moisture accounting. 

Advanced capabilities can that be provided by HEC-HMS is gridded runoff simulation 
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using linear quasi-distributed runoff transform(ModClark). Furthermore, there are also 

supplemental analysis tools that provided for model optimization, forecasting 

streamflow, depth-area reduction, assessing model uncertainty, erosion and sediment 

transport and water quality. (Engineers, 2018) 

The software of HEC-HMS features a completely integrated work environment 

including a database, data entry utilities, computation engine and results reporting tools. 

A graphical user interface allows the user seamless movement between the different 

parts of the software. Simulation results are stored in Data Dtorage System (HEC-DSS) 

and can be used in conjunction with other software for studies of water availability, 

urban drainage, flow forecasting, future urbanization impact, reservoir spillway design, 

flood damage reduction, floodplain regulation and systems operation. (Engineers, 

Hydrologic Engineering Center, 2018) 

There are some function that are available in HEC-HMS such as: 

 Watershed Physical Description 

 Meteorology Description 

 Hydrologic Simulation 

 Model Optimization 

 Forecasting Streamflow 

 Depth-Area Reduction 

 Assessing Model Uncertainty 

 Sediment and Water Quality 

 GIS Connection 

2.8.5 HEC-RAS 

HEC-RAS software have the function to allows the user to perform one-

dimensional steady flow, unsteady flow calculation, sediment transport/mobile bed 

computations and water temperature/water quality modelling. A key element is that all 
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four components use a common geometric data representation and common geometric 

and hydraulic computation routines. In addition to these river analysis components, the 

system contains several hydraulic design features that can be invoked once the basic 

water surface profiles are compute. (Engineers, 2018) 

HEC-RAS is designed to perform one and two-dimesional hydraulic 

calculations for a full network of natural and constructed channels. The following is a 

description of the major capabilities that be provided in HEC-RAS: 

 Hydraulic Analysis Components 

 Data Storage and Management 

 Graphics and Reporting 

 RAS Mapper 
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CHAPTER 3 

 

 

METHODOLOGY 

3.1 Introduction 

Section 1, Bandar Baru Bangi is located at Bangi, Selangor was chosen as a 

study area. It has a capacity of 535 people including the elderly and children. This 

urban area has existed for 40 years, thus the mainly people that populated in this area is 

the elderly. 

The drainage system in this urban area is concrete channel. The area of this 

urban area is near the river and this area is low-lying area compared to its surroundings. 

Thus, flood and overflow frequently happen in this area. A study should be made to 

investigate the efficiency of the drainage system. 
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3.2 Flow Chart of the Study 

Figure 3.1 shows how the study at Section 1, Bandar Baru Bangi Selangor was 

conducted. 

 

Figure 3.1 Methodology of the study 
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3.3 Study Area 

Figure 3.2 shows the location of study, Section 1, Bandar Baru Bangi at the 

early stage of the study, checking on the effected area of was conducted as the overflow 

in the and the drainage was old too. It has only one sub-catchment of 4 hectares in size 

after some time, the old drainage is being replaced by Majlis Pembandaran 

Kajang(MPKj) as they received a report on the overflow from the area. As the old 

drainage has been replaced, it is worth to study the difference of the efficiency of the 

both of old and new drainage to check whether the new size of drainage is suitable for 

the area. It had only one sub-catchments area which is the area itself. The location area 

is shown in Figure 3.2.  

3.3.1 Study Area Observation 

Site visit and observation were carried out in order to get a better understanding 

on the problems occur in this area especially at the main drains. Problematic drains 

were identified and their data such as dimensions and lengths were recorded. The 

criteria of the drain such as material, size and slope were also detailed. Others 

observations such as the location of houses and blocks were noted as shown in Figure 

3.2. These information of the Section 1, Bandar Baru Bangi is compared with the 

layout(Figure 3.3) that have be obtained from Satria Aces Synergy(M) Sdn. 

Bhd.(Contractor).  
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Figure 3.2 Section 1, Bandar Baru Bangi 

 

Figure 3.3 Layout Plan for Section 1, Bandar Baru Bangi 
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3.4 Data and Information Collection 

There are various data and information that needed to be determined in this 

study. Those data of concerned are rainfall data, drainage dimension, slope of drainage 

and flow direction. All the data collected were based on the need of the Hec-HMS and 

Hec-Ras software application. All the data related to the hydrological properties, 

drainage characteristics, and features involves about the area were obtained in order to 

run the simulation successfully. 

3.4.1 Rainfall Data 

Rainfall data were obtained from DID. The duration of rainfall data is collected 

from the year 2007 until 2017. The location of rainfall data station is at Kajang and 

Sungai Rinching station. The rainfall data were used to determine the rainfall intensity, 

I. 

3.4.2 Drainage Dimension and Roughness 

Drainage dimension is determined by using measuring tape. The dimension is to 

get the cross sectional area of the drains. The roughness coefficient, n is based on the 

material of the drains. The value in Manning’s Equation is used to determined drain 

discharge. 

3.4.3 Slope of Drain 

Slope of drainage is measure by levelling method by their aids of tripod, 

transverse and levelling stuff. These tools required at least two people to record the 

levels. From the levels, slope of the drains were calculated. The slope’s data were 

prepared by the contractor, Satria Aces Synergy(M) Sdn.Bhd. 

3.4.4 Flow Direction 

Flow directions were also noted to determine the type of drainage pattern at this 

area. Flow direction will ensure the slope and the flow of water in drainage system flow 

in gravitational manner. All these information were plotted by using AutoCAD 

software. 
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3.5 Method to Calculate the Discharge 

After all of the data were obtained, analysis of the result begun. The capacity of 

the existing drain and the runoff discharge also the old drain and it’s runoff discharge 

were calculated. These values were compared to determine the efficiency of the existing 

drain and the old drain. There values is also depends on the area of the cross section of 

the drainage as the area is also one of variable in discharge.  

 Performance of each main drain was estimated by this comparison to 

determine any failure. MSMA was used to determine the runoff discharge and the 

Manning equation was used to get the drain capacity. 

3.5.1 The Maximum Discharge of Drains 

Drainage should be designed after the runoff discharge was obtained from the 

Rational Method’s formula. The Manning’s Equation is used in channel design to get 

the peak discharge in the drain. The assumption of the Manning’s Equation state that 

the discharges are similar along the uniform channel. 

3.5.2 The Peak Runoff Discharge 

In MSMA, there are two methods to calculate the runoff capacity causes by 

rainfall. The two methods are rainfall method and hydrograph method. The Rational 

Method is influence by rainfall intensity and peak runoff with suitable coefficient. 

Meanwhile, Hydrograph Method are depend on rainfall hydrograph and rainfall losses, 

temporary storage effect in transit and transit and discharge hydrograph. 

3.5.2.1 Rational Method 

Rational method is one of the effective methods in a small catchment area. It is 

easier than hydrograph method because the data and information needed is not much 

comparing to hydrograph method.  
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3.5.2.2 Runoff Coefficient Estimation, C 

Runoff coefficient is a runoff quantity factor compare to the rainfall capacity at 

a catchment area. This coefficient is influenced by several factors such as weather and 

topography of catchment area. Value of runoff coefficient can be estimated from 

Chapter 2, MSMA 2012.  

3.5.2.3 Rainfall Intensity, I, Selection 

In this study, rainfall intensity, I that was obtained from the rainfall data. 

Selected for 11 years starting from January 2007 until December 2017. The selected 

stations, the Kajang rainfall station and Sungai Rinching rainfall station whereas this 

two stations are the nearest station in the study area. In order to get the rainfall intensity, 

maximum rainfall were converted into mm/hr. Rainfall data were attached in Appendix. 

3.6 Data Analysis 

After all the data needed in the HEC-HMS had been required, the simulation 

could be run by following steps to obtain the hydrograph. After the hydrograph had 

been obtained from the HEC-HMS, the hydrograph was inserted in HEC-RAS to check 

whether there were overflow in the drainage system or not. 
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3.6.1 HEC-HMS 

The analysis of the data to obtain the hydrograph is being performed using 

HEC-HMS application with all the collected data as the input. It is important to 

understand all the process involved and the type of data use in each process, thus Figure 

3.4 explains the process involve in modelling drainage simulation. 

The steps outlined below need to be followed to achieve the desired result. 

1. Firstly, create a new project in HEC-HMS with details as shown in the 

Figure 3.4. 

 

Figure 3.4 Creating a new project. 

 

2. After that, create components of basin model manager and when the tab 

popup, create a new data as in the Figure 3.5 and close the tab. 
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Figure 3.5 Creating a new project 

 

3. Then, create a sub-basin model of the catchment area and fill the detail. 

In the left below, fill in all the important information needed for the 

catchment area where there are “*” sign in it as show in the Figure 3.6. 

 

Figure 3.6 Catchment Area. 
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4. Next, click on the component the select Time-Series Data Manager as 

we need to set the time of the simulation and to know the time taken to 

reach the peak flow. In the details of Time-Series Data Manager, put on 

the details of one day simulation and fill in the precipitation value as in 

Figure 3.7. 

 

Figure 3.7 Insert the precipitation and time details. 

 

5. After that, click on the Meteorologic Model Manager and create a new 

Meteorologic data as shown in Figure 3.8. This is a crucial part of this 

software and must be follows through to avoid error when run 

simulation. 
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Figure 3.8 Create a new Meteorologic Data 

 

6. Then, change the replace missing details from “Abort Compute” to “Set 

To Default” as in Figure 3.9 and after that, click on the specified 

hydrograph and choose gage 1 to ensure that all the sub-basin in the 

catchment area is being compute as shown in Figure 3.10. 
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Figure 3.9  “Replace missing” data change 

 

Figure 3.10 Selecting the “Gage 1” 

 

7. Lastly, click on component and choose Control Specification Manager 

and create a new control and fill the detail of date and time, same as the 

Time-Series Data Manager with time interval 5 minutes as shown in 

Figure 3.11. 
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Figure 3.11 Details of Time-Series Data Manager 

 

8. After all data has been completed fill. Click on the compute and do a run 

simulation as shown in Figure 3.12. 

 

Figure 3.12 Simulation Run 
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9. If there are no error, the run will finished within a seconds and we can 

obtain the result and also hydrograph while if there are some error, the 

software will abort compute and list down the error on the commands 

space. Figure 3.13 shows the completed simulation run with no error. 

 

Figure 3.13 Completed Simulation Run with no error. 

 

10. Then, click on the table icon to view the summarize result of the 

simulation run as shown in Figure 3.14. 
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Figure 3.14 Global Summary Report 

 

3.6.2 HEC-RAS 

In this software, the analysis result from the Hec-HMS is being an input to this 

software to check whether there are overflow in the drains of the area of study. It is 

crucial part as the result of this software may cause the need to change of drain’s design 

in the study area. Thus, every step in the software must be followed to avoid an error 

from happening. 

The steps to compute are as below:  

1. Firstly, create a file wherever desire in the laptop as shown in the Figure 

3.15. 
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Figure 3.15 Create a new folder 

 

2. Next, open Hec-Ras click on the File>New Project, select the folder that 

have been made and fill in the details of the project and click “OK” as 

shown in Figure 3.16. 

 

Figure 3.16 Creating a new project 
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3. Click on the Edit>Geometric Data … as shown in the Figure 3.17 and 

the new window will popup. 

 

Figure 3.17 Geometric Data 

4. In the new window, click on File>New Geometry Data and save the file 

in the same folder as the project file as shown in the Figure 3.18. 

 

Figure 3.18 Saving the Geometric Data 

 

5. Click on River Reach, and draw a line in the area provided, the length of 

the line can be adjusted in GIS Tools>Reach Invert Lines Table and 

check the line length and change the length according to the necessary as 

shown in Figure 3.19. 
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Figure 3.19 Editing Reach Invert Lines Table 

 

6. To insert the cross section details, click on Cross Section and when the 

new window appear, click on Option>Add a new Cross Section as 

shown in Figure 3.20 then insert the numbering of cross section and 

click OK as in the Figure 3.21. 

 

Figure 3.20 Add new Cross Section 
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Figure 3.21 Cross Section Station 

 

7. Enter the details of the drains and click on apply data. If the apply data is 

not click on, the details will not be save by the software and then click 

on exit as in the Figure 3.22. 

 

Figure 3.22 Cross Section Data 

 

8. Save the geometry data file and click on File>Exit Geometry Data Editor 

to close the window. 
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9. Next, click on Edit>Unsteady Flow Data … as shown in the Figure 3.23. 

 

Figure 3.23 Unsteady Flow 

 

10. After the new window appear click on Boundary Condition and select on 

Flow Hydrograph as in the Figure 3.24. 

 

Figure 3.24 Selecting Flow Hydrograph Data 
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11. Insert the data that have been obtained in Hec-HMS by clicking the Flow 

hydrograph. Select the date and time run simulation and fill in the 

discharge table and click “OK” as shown in the Figure 3.25. 

 

Figure 3.25 Unsteady Flow Data from Hydrograph 

 

12. Save the data and exit the unsteady flow data as shown in the Figure 

3.26. 
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Figure 3.26 Exiting Unsteady Flow Data 

 

13. Click on the Run>Unsteady Flow Analysis as shown in Figure 3.27. 

 

Figure 3.27 Unsteady Flow Analysis 
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14. Fill on the details as shown in Figure 3. 38 and click on Compute to run 

the Simulation. 

 

Figure 3.28 Details of Unsteady Flow Analysis 

 



54 

Figure 3.29 shows the end of the simulation of the unsteady flow, then click on “Close”.  

 

Figure 3.29 Simulation of Unsteady Flow 
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CHAPTER 4 

 

 

RESULTS AND DISCUSSION  

4.1 Introduction 

Before a new drainage system is designed in a new development, the existing 

drain capacity is estimated to ensure it is suitable and practical with the runoff discharge 

on that area for the past year. Recently, there are sudden increase of runoff discharge 

due to the drastic change in weather thus a confirmation calculation is executed in this 

study to check the design of the drainage system.  

The old drainage may not be able to adapt to the drastic change of weather, thus, 

cause an overflow that affect the residential activity in the area. Thus, the study is 

carried out to check whether the new size of drainage block in this drainage system can 

afford to tackle the runoff discharge during the heavy rain. A study on the drain 

capacity using the Manning’s equation could prove the flood occurrences in this area. 

The slope of each drain also gives an important factor in decreasing a runoff 

discharge and decrease the occurance of flood. Usually, the slope of drain follows the 

land slope but it is also some case that the slope of drain and land slope is different. The 

topography of the land area makes the drain slope different from the land slope. All of 

the new drainage system of this area is already completed and hopefully it might solve 

the overflow of some part of the drainage. 

4.2 Observation at Section 1, Bandar Baru Bangi 

An observation was made in this study area and it was determined that the 

drainage system in this area is simple and not perfect. There are some areas where 

overland flow and runoff discharge that the drains cannot cater. This resulted erosion at 

some part of the studied area. 
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The catchment area of this study is 4.3 hectares with link house where the 

occupants lives in the area for almost 50 years. This catchment can be divided into three 

sections according to the flow of the water in the drainage and the contour of the area. 

The flow of discharge is from the high elevation area to the low elevation area and it 

based on gravitational concept. 

4.3 Drainage Pattern at Section 1, Bandar Baru Bangi 

The topography at the catchment area in Section 1, Bandar Baru Bangi is almost 

flat and the water flow from high elevation to lower elevation. This surface runoff water 

entered the existing drainage and later removed at the lower elevation. This area 

consists of 3 sub-catchment area with one outflow. 

The main drains in this area are collected the water from the road and roof then 

being transferred to the small drains and from there to the outfalls points of the drainage 

system. According to the plan view of the area of study, the drainage pattern of the 

Section 1, Bandar Baru Bangi is rectangular drainage as shown in Figure 4.1. 

Rectangular drainage pattern in which the tributaries join the main streams at 

right angles in which the drainage pattern is currently adapted in the study area, this 

type of pattern is mostly the very common in the residential area. As the rectangular 

have a simple design as the design in the residential area where the block is functional 

as the bedrockfault as shown in the Figure 4.2. 
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Figure 4.1 Rectangular Drainage Pattern at Section 1, Bandar Baru Bangi  
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Figure 4.2 Comparison between Section 1 Catchment Area and Rectangular 

Drainage Pattern 
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4.4 Catchment Area 

This study involved an area of 4.3 hectares of Section 1, Bandar Baru Bangi that 

located in residence area. The longest drains with a total of 28 chainage is 316.22m. 

The direction of flow is from CH28 to CH1 with the slope of 0.006. Figure 4.3 shows 

the actual study area with the details. The catchment is divided into 3 sub-catchments 

with an area of 2.17, 1.33 and 0.79 hectares roughly. 

 

 Figure 4.3 Details of Catchment Area 

 

 

4.5 The Capacity of Drains (MSMA) 

According to the MSMA, there are calculation that can be used to determine the 

discharge of the drains and the discharge of the estimated rainfall. The calculation of 

the discharge of drains included are the wetted perimeter of the drains, the area of the 

drains, hydraulics radius, slope and Manning Roughness. Meanwhile, the calculation of 

the discharge of the estimated rainfall is include rainfall intensity, runoff coefficient and 

area of catchment. 

All of the drain materials are made of concrete. In this study area, the outlet for 

the catchment area is only one thus the depth of the outlet must be greater than the 

depth of the sub-catchment area drains as the capacity increases at the outlet. The 

design of the discharge drain must be bigger than the discharge of the estimated rainfall. 

Catchment Area: 4.3 ha Slope: 0.006 

Length Drain: 292 m 
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4.5.1 Calculation for Peak Drains Discharge Using the Manning’s Equation 

Figure 4.4 shows the details of the drains block that used in the study area. 

Meanwhile, Figure 4.5 shows the drain details for the constructed drain that are used to 

calculate the discharge capacity. 

There are several assumtions in using the Manning equation: 

 The diameter of half circle is the same width as the bottom of drainage 

blocks. 

 The slope of whole catchment area is the same. 

 

Figure 4.4 Details of Drains used 
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Figure 4.5 Dimension Details of Drain (JKR) 

 

Manning equation,    
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Top Width = 0.485 m 

Depth  = 0.375 m 

Diameter = 0.25 m 
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Hydraulic Radius, R = A/P 
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   =0.174 m 
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    = 0.478 m³/s (Drain Capacity) 
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The slope of this area is calculated from the highest elevation to the lowest 

elevation and the slope is used on every calculation of drain in different sub-catchment 

where the velocity of flow might be different. The diameter of the half circle is assumed 

similar to the bottom width and the rest as trapezoidal because the lower bottom of the 

trapezoidal is the boundary of the half circle diameter thus, the diameter were assumed 

the width of bottom’s drains block. 

4.5.2 Calculation for Peak Discharge Using the Rational Method 

There are several assumtions in using the Rational method: 

 Rainfall intensity is assumed to be same at all catchment area. 

 Rainfall intensity is uniform with rainfall time which is same with time 

of concentration. 

Kajang Rainfall station was choosen since it is the nearest station to the study 

area. The runoff coefficient of the catchment area is 0.8(link & terrace house). The 

rainfall intensity was calculated based on Chapter 2 of MSMA (2012). 

Rational Method,   
   

   
 

Rainfall Intensity,   
(   )

(   ) 
 

Where, 

λ  = 59.153 

k  = 0.161 

d  = 0.0833 

θ  = 0.118 

ARI, T  = 2 years 

    
(             )

(            )     
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     = 243.06 mm/hr 

   
(   )(      )(       )

   
 

     = 0.81 m³/s (Peak Discharge) 

4.6 Comparison of Peak Runoff Discharge and Maximum Discharge of Sub-

Catchment Area. 

The runoff of study area flows from high elevation to lower elevation thus, in 

the last cross-sectional area of drains is calculated to check whether the design drains 

can occupy the peak runoff discharge of the flow in the area. Table 4.1 shows the 

calculation result of peak runoff discharge and drainage discharge of sub-catchment 

area. 

 

Table 4.1 Comparison of Peak Discharge and Drainage Discharge 

Sub-

Catchment  

Qpeak 2 years 

ARI (m³/s) 

Qpeak 5 years 

ARI (m³/s) 

Qpeak 10 years 

ARI (m³/s) 

Qdrain 

(m³/s) 

1 0.72 0.83 0.93 0.79 

2 0.59 0.69 0.77 0.66 

3 0.29 0.33 0.37 0.33 

Total 1.6 1.85 2.07 1.78 

 

From Table 4.1, we can conclude that the design of the drains was for 2 years 

ARI because the drains discharge is only exceeding on 2 years ARI. For the 5 and 10 

years ARI, the discharge is too large for the drains to handle. If the drain is to cater for 

5 years ARI and 10 years ARI, the depth of the drains need to be deepen.   

4.7 Result of Simulation Process 

There are two types of software that be used in this study which is the Hec-Ras 

and Hec-HMS. The used of the Hec-HMS is to find the unit hydrograph and the 

discharge of the study area while the Hec-Ras is used to check whether there are 

overflow in drainage system of the study area. 
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4.7.1 HEC-HMS Results 

The results that be obtained from the Hec-HMS is based on slope, storm 

duration, baseflow, area of study, type of area and time of concentration. This result can 

be divided into two types, unit hydrograph and summary results. The results consists of 

three different years, 2, 5 and 10 years ARI. The results are shown in Figure 4.6, 4.7, 

4.8, 4.9, 4.10 and 4.11, respectively. 

From the Figure 4.6 to Figure 4.11, the result obtained from the HEC-HMS can 

be summarize as The table 4.2. 10 years ARI recorded the highest value for volume 

discharge as expected. 

Table 4.2 Summarize Result of HEC-HMS 

Variable 2 Years ARI 5 Years ARI 10 Years ARI 

Peak Discharge(m³/s) 1.20 1.20 1.30 

Precipitation Volume(mm) 22.80 26.43 29.55 

Loss Volume(mm) 1.98 1.98 1.97 

Excess Volume(mm) 20.82 24.45 27.58 

Direct Runoff Volume(mm) 20.82 24.45 27.58 

Baseflow Volume(mm) 2009.30 2009.30 2009.30 

Discharge Volume(mm) 2030.12 2033.75 2036.88 
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Figure 4.6 Unit Hydrograph for 2 Years ARI 

 

 

Figure 4.7 Summary Results for 2 Years ARI 
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Figure 4.8 Unit Hydrograph for 5 Years ARI 

 

 

Figure 4.9 Summary Results for 5 Years ARI 
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Figure 4.10 Unit Hydrograph for 10 Years ARI 

 

 

Figure 4.11 Summary for 10 Years ARI 

 

 

 

 

 

4.7.2 HEC-RAS Results 

The results that were obtained from the Hec-Ras is based on discharge result 

from Hec-HMS, the drainage cross section and the length of drains from the drawing, 
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and the duration of simulation. The cross sections illustrated the analysis based on the 

three different years, 2, 5 and 10 years ARI. 

Figure 4.12 shows the chainage of the drains that have been drawn in the 

geometry data in Hec-Ras software. The chainage start from CH 28 (the highest 

elevation) to the CH 1 (the lowest elevation) according to the direction of flow. 

Meanwhile, Figure 4.13 shows the length (316.33m) of the drains system of the study 

area. This length is selected because it has the longest length compare to the other sub-

catchment.  

 

Figure 4.12 Geometry Data 

 



69 

 

Figure 4.13 The length of drains in the study area 

 

 

 

4.7.2.1 Water Level for 2 Years ARI 

Simulation were carried out with one day simulation at 2 years ARI from the 

highest point of drain’s elevation to the lowest point of drain’s elevation. The cross 

section of drains consists of Water Surface Profile and Ground Profile. Figure 4.14 to 

Figure 4.41 exhibited the drain capacity. 

According to the Figure 4.14 to Figure 4.21, at the beginning of the drainage 

system from the 2 years ARIs, there are no overflow of water recorded as the drains 

depth is sufficient enough to cater the flow from the catchment area. No overflow were 

recorded occur at the stage from CH 28 until CH 15 (Figure 4.14 to Figure 4.27). 

overflow were observed at CH 14, CH 13, CH 3, CH 2 and CH 1 as the flow started to 

accumulate. 



70 

 

Figure 4.14 Cross Section CH28 (Highest Elevation)(2 YEARS ARI) 

 

 

Figure 4.15 Cross Section CH27(2 YEARS ARI) 
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Figure 4.16 Cross Section CH26(2 YEARS ARI) 

 

 

Figure 4.17 Cross Section CH25(2 YEARS ARI) 
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Figure 4.18 Cross Section CH24(2 YEARS ARI) 

 

 

Figure 4.19 Cross Section CH23(2 YEARS ARI) 
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Figure 4.20 Cross Section CH22(2 YEARS ARI) 

 

 

Figure 4.21 Cross Section CH21(2 YEARS ARI) 
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Figure 4.22 Cross Section CH20(2 YEARS ARI) 

 

 

Figure 4.23 Cross Section CH19(2 YEARS ARI) 
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Figure 4.24 Cross Section CH18(2 YEARS ARI) 

 

 

Figure 4.25 Cross Section CH17(2 YEARS ARI) 
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Figure 4.26 Cross Section CH16(2 YEARS ARI) 

 

 

Figure 4.27 Cross Section CH15(2 YEARS ARI) 
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Figure 4.28 Cross Section CH14(2 YEARS ARI) 

 

 

Figure 4.29 Cross Section CH13(2 YEARS ARI) 
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Figure 4.30 Cross Section CH12(2 YEARS ARI) 

 

 

Figure 4.31 Cross Section CH11(2 YEARS ARI) 
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Figure 4.32 Cross Section CH10(2 YEARS ARI) 

 

 

Figure 4.33 Cross Section CH9(2 YEARS ARI) 
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Figure 4.34 Cross Section CH8(2 YEARS ARI) 

 

 

Figure 4.35 Cross Section CH7(2 YEARS ARI) 
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Figure 4.36 Cross Section CH6(2 YEARS ARI) 

 

 

Figure 4.37 Cross Section CH5(2 YEARS ARI) 
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Figure 4.38 Cross Section CH4(2 YEARS ARI) 

 

 

Figure 4.39 Cross Section CH3(2 YEARS ARI) 
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Figure 4.40 Cross Section CH2(2 YEARS ARI) 

 

 

Figure 4.41 Cross Section CH1 (Lowest Elevation) (2 YEARS ARI) 

 

4.7.2.2 Water Level for 5 Years ARI 

Simulation were carried out with one day simulation at 5 years ARI from the 

highest point of drain’s elevation to the lowest point of drain’s elevation. The cross 
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section of drains consists of Water Surface Profile and Ground Profile. In the cross 

section, the overflow of drainage can also be detected. The cross section of drains can 

be view in the Figure 4.42 to Figure 4.69 below. 

According to the Figure 4.42 to Figure 4.69 of the drains cross section, the 

overflow happen in the same CH as 2 years ARI where it is happen from CH 14 to CH 

13 and from CH 3 to CH 1. Meanwhile, there are additional of the drainage that almost 

have an overflow, which is from CH 8 to CH 6. The rest of the drains were able to 

accumulate to the design of 5 years ARI. 
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Figure 4.42 Cross Section CH28 (Highest Elevation) (5 YEARS ARI) 

 

 

Figure 4.43 Cross Section CH27(5 YEARS ARI) 
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Figure 4.44 Cross Section CH26(5 YEARS ARI) 

 

 

Figure 4.45 Cross Section CH25(5 YEARS ARI) 
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Figure 4.46 Cross Section CH24(5 YEARS ARI) 

 

 

Figure 4.47 Cross Section CH23(5 YEARS ARI) 
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Figure 4.48 Cross Section CH22(5 YEARS ARI) 

 

 

Figure 4.49 Cross Section CH21(5 YEARS ARI) 
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Figure 4.50 Cross Section CH20(5 YEARS ARI) 

 

 

Figure 4.51 Cross Section CH19(5 YEARS ARI) 
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Figure 4.52 Cross Section CH18(5 YEARS ARI) 

 

 

Figure 4.53 Cross Section CH17(5 YEARS ARI) 
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Figure 4.54 Cross Section CH16(5 YEARS ARI) 

 

 

Figure 4.55 Cross Section CH15(5 YEARS ARI) 
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Figure 4.56 Cross Section CH14(5 YEARS ARI) 

 

 

Figure 4.57 Cross Section CH13(5 YEARS ARI) 
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Figure 4.58 Cross Section CH12(5 YEARS ARI) 

 

 

Figure 4.59 Cross Section CH11(5 YEARS ARI) 
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Figure 4.60 Cross Section CH10(5 YEARS ARI) 

 

 

Figure 4.61 Cross Section CH9(5 YEARS ARI) 
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Figure 4.62 Cross Section CH8(5 YEARS ARI) 

 

 

Figure 4.63 Cross Section CH7(5 YEARS ARI) 
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Figure 4.64 Cross Section CH6(5 YEARS ARI) 

 

 

Figure 4.65 Cross Section CH5(5 YEARS ARI) 
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Figure 4.66 Cross Section CH4(5 YEARS ARI) 

 

 

Figure 4.67 Cross Section CH3(5 YEARS ARI) 

 



98 

 

Figure 4.68 Cross Section CH2(5 YEARS ARI) 

 

 

Figure 4.69 Cross Section CH1 (Lowest Elevation) (5 YEARS ARI) 

 

4.7.2.3 Water Level for 10 Years ARI 

Simulation were carried out with one day at 10 years ARI from the highest point 

of drain’s elevation to the lowest point of drain’s elevation. The cross section of drains 
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consists of Water Surface Profile and Ground Profile. In the cross section, the overflow 

of drainage can also be detected. The cross section of the drains for 10 years ARI can be 

viewed in Figure 4.70 to Figure 4.97. 

According to the Figure 4.70 to Figure 4.97, the drains design is unable to cater 

the flow for10 years ARI storm duration as there were a lot of drains failure and 

overflow in the area. The failed drain can be viewed at the CH 28 to CH 26, from CH 

22 to CH 6 and from CH 3 to CH 1. As for the almost failed drainage can be detected in 

CH 5 as the overflow is happened from CH 22 to CH 6. Thus, the drainage will failed 

and overflow if there are 10 years ARI storm duration happen in the area. 

 

Figure 4.70 Cross Section CH28 (Highest Elevation) (10 YEARS ARI) 
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Figure 4.71 Cross Section CH27(10 YEARS ARI) 

 

 

Figure 4.72 Cross Section CH26(10 YEARS ARI) 
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Figure 4.73 Cross Section CH25(10 YEARS ARI) 

 

 

Figure 4.74 Cross Section CH24(10 YEARS ARI) 
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Figure 4.75 Cross Section CH23(10 YEARS ARI) 

 

 

Figure 4.76 Cross Section CH22(10 YEARS ARI) 
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Figure 4.77 Cross Section CH21(10 YEARS ARI) 

 

 

Figure 4.78 Cross Section CH20(10 YEARS ARI) 
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Figure 4.79 Cross Section CH19(10 YEARS ARI) 

 

Figure 4.80 Cross Section CH18(10 YEARS ARI) 
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Figure 4.81 Cross Section CH17(10 YEARS ARI) 

 

 

Figure 4.82 Cross Section CH16(10 YEARS ARI) 
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Figure 4.83 Cross Section CH15(10 YEARS ARI) 

 

 

Figure 4.84 Cross Section CH14(10 YEARS ARI) 
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Figure 4.85 Cross Section CH13(10 YEARS ARI) 

 

 

Figure 4.86 Cross Section CH12(10 YEARS ARI) 
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Figure 4.87 Cross Section CH11(10 YEARS ARI) 

 

 

Figure 4.88 Cross Section CH10(10 YEARS ARI) 
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Figure 4.89 Cross Section CH9(10 YEARS ARI) 

 

 

Figure 4.90 Cross Section CH8(10 YEARS ARI) 
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Figure 4.91 Cross Section CH7(10 YEARS ARI) 

 

 

Figure 4.92 Cross Section CH6(10 YEARS ARI) 
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Figure 4.93 Cross Section CH5(10 YEARS ARI) 

 

 

Figure 4.94 Cross Section CH4(10 YEARS ARI) 
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Figure 4.95 Cross Section CH3(10 YEARS ARI) 

 

 

Figure 4.96 Cross Section CH2(10 YEARS ARI) 
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Figure 4.97 Cross Section CH1 (Lowest Elevation) (10 YEARS ARI) 

 

4.8 Analysis of Simulation Result of Drains 

From the simulation, it is obvious that the drain was designed to cater for 2 

years ARI only. Should the 5 years ARI and 10 years ARI were to be considered, the 

drainage depth should be deepen. Table 4.3 shows the analysis and comparison result of 

simulation in three different ARIs. 

CH 25, CH 24, CH 23, CH 5 and CH 4 has a suitable depth as there are sump in 

the chainage 

Table 4.3 Comparison of Simulation ARI of Drains 

CH 2 Years ARI 5 Years ARI 10 Years ARI 

Capacity Remark Capacity  Remark Capacity Remark 

CH28 Ok Ok Ok Ok Overflow Fail 

CH27 Ok Ok Ok Ok Overflow Fail 

CH26 Ok Ok Ok Ok Overflow Fail 

CH25 Ok Ok Ok Ok Ok Ok 

CH24 Ok Ok Ok Ok Ok Ok 

CH23 Ok Ok Ok Ok Ok Ok 

CH22 Ok Ok Ok Ok Overflow Fail 

CH21 Ok Ok Ok Ok Overflow Fail 

CH20 Ok Ok Ok Ok Overflow Fail 

CH19(Sump) Ok Ok Ok Ok Overflow Fail 

CH18(Sump) Ok Ok Ok Ok Overflow Fail 

CH17 Ok Ok Ok Ok Overflow Fail 
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CH16 Ok Ok Ok Ok Overflow Fail 

CH15 Ok Ok Ok Ok Overflow Fail 

CH14 Overflow Fail Overflow Fail Overflow Fail 

CH13 Overflow Fail Overflow Fail Overflow Fail 

CH12(Sump) Ok Ok Ok Ok Overflow Fail 

CH11(Sump) Ok Ok Ok Ok Overflow Fail 

CH10 Ok Ok Ok Ok Overflow Fail 

CH9 Ok Ok Ok Ok Overflow Fail 

CH8 Ok Ok Ok Ok Overflow Fail 

CH7 Ok Ok Ok Ok Overflow Fail 

CH6 Ok Ok Ok Ok Overflow Fail 

CH5(Sump) Ok Ok Ok Ok Ok Ok 

CH4(Sump) Ok Ok Ok Ok Ok Ok 

CH3 Overflow Fail Overflow Fail Overflow Fail 

CH2 Overflow Fail Overflow Fail Overflow Fail 

CH1 Overflow Fail Overflow Fail Overflow Fail 

 

 

 

 

CHAPTER 5 

 

 

CONCLUSION 

5.1 Conclusion 

The main objectives of the study is to check the capacity of the drainage system 

by using HEC-HMS and HEC-RAS by run the simulation of 2 years, 5 years and 10 

years ARI of the drainage system in the study area. The outcome of the simulation by 

using HEC-HMS is the unit hydrograph and time series data, which can be used as an 

input data in HEC-RAS. Meanwhile, the outcome of simulation by using HEC-RAS is a 

model of cross section of the drainage which we can see roughly details of the water 
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flow. The simulation was run under basic condition on rainfall catchment area due to 

lack of several data. 

At the early stage of the study, the catchment area of study area can be divided 

into three sub-catchment. Each of the sub-catchment has different area and different 

length and depth of drains to begin with and there is a need to calculate each one of it. 

The total area of the study is 4.3 hectares and each of the sub-catchment area is 2.17, 

1.33 and 0.79 hectares roughly. The drainage system consists of 28 cross section and 

with the length 316.22 metre. 

The other objectives of this study is to determine type of drainage pattern of the 

study area. According to the plan of the drainage, the pattern of the drainage system is 

almost similar to the rectangular drainage pattern. Rectangular drainage pattern transfer 

water flow from higher level to the lower level by using gravitational principle and has 

rectangle shape.  

 

After conducting several simulations and study on the drainage system using 

HEC-HMS and HEC-HMS software developed by Hydrologic Engineering Center and 

by data analysis, a few conclusions were made from the study results. 

At the beginning of the result of 2 years ARI, there are some overflow of the 

drainage which we can see at the CH 14 to CH 13 and from CH 3 to CH 1. There are 

also section recorded barely full at CH 7 to CH 6. For safety measure, it is 

recommended to redesign the problematic section to cater the storm of 2 years ARI. 

For 5 years ARI, the drains cross section, the overflow occurred at the similar 

chainage as that of 2 years ARI (CH 14 to CH 13 and from CH 3 to CH 1). Meanwhile, 

there are additional of the drainage that almost have an overflow, which is from CH 8 to 

CH 6. The rest of the drain section were able to accomodate to the design of 5 years 

ARI. 

For 10 years ARI, the drain design is unable to cater for the storm duration as 

there were a lot of drains failure and overflow were recorded in the area. The overflow 
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drains can be observed at the CH 28 to CH 26, from CH 22 to CH 6 and from CH 3 to 

CH 1. The existing of the sumps at these sections contributed to the recorded scenarios.  

As a summary, the existing drains were design to cater for 2 years ARI only. 

Overflow of the drains were recorded for 5 years ARI and 10 years ARI. 

5.2 Recommendations 

Recommendation is a suggestion or proposal as to the best course action. In order to 

get a more precise and beneficial results :  

i. Set up a rainfall station near the study area to give a precise rainfall data. 

ii. Add more of cross section data to the drainage system. 

iii. Use multiples software to run the simulation of overflow in the area. 
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APPENDIX A 

DISCHARGE DATA FOR 2 YEARS ARI 

 

 

Date Time Flowrate Date Time Flowrate

1-Jan-17 0:00 1.0 1-Jan-17 12:00 1.0

1-Jan-17 0:15 1.1 1-Jan-17 12:15 1.0

1-Jan-17 0:30 1.2 1-Jan-17 12:30 1.0

1-Jan-17 0:45 1.2 1-Jan-17 12:45 1.0

1-Jan-17 1:00 1.1 1-Jan-17 13:00 1.0

1-Jan-17 1:15 1.1 1-Jan-17 13:15 1.0

1-Jan-17 1:30 1.1 1-Jan-17 13:30 1.0

1-Jan-17 1:45 1.1 1-Jan-17 13:45 1.0

1-Jan-17 2:00 1.0 1-Jan-17 14:00 1.0

1-Jan-17 2:15 1.0 1-Jan-17 14:15 1.0

1-Jan-17 2:30 1.0 1-Jan-17 14:30 1.0

1-Jan-17 2:45 1.0 1-Jan-17 14:45 1.0

1-Jan-17 3:00 1.0 1-Jan-17 15:00 1.0

1-Jan-17 3:15 1.0 1-Jan-17 15:15 1.0

1-Jan-17 3:30 1.0 1-Jan-17 15:30 1.0

1-Jan-17 3:45 1.0 1-Jan-17 15:45 1.0

1-Jan-17 4:00 1.0 1-Jan-17 16:00 1.0

1-Jan-17 4:15 1.0 1-Jan-17 16:15 1.0

1-Jan-17 4:30 1.0 1-Jan-17 16:30 1.0

1-Jan-17 4:45 1.0 1-Jan-17 16:45 1.0

1-Jan-17 5:00 1.0 1-Jan-17 17:00 1.0

1-Jan-17 5:15 1.0 1-Jan-17 17:15 1.0

1-Jan-17 5:30 1.0 1-Jan-17 17:30 1.0

1-Jan-17 5:45 1.0 1-Jan-17 17:45 1.0

1-Jan-17 6:00 1.0 1-Jan-17 18:00 1.0

1-Jan-17 6:15 1.0 1-Jan-17 18:15 1.0

1-Jan-17 6:30 1.0 1-Jan-17 18:30 1.0

1-Jan-17 6:45 1.0 1-Jan-17 18:45 1.0

1-Jan-17 7:00 1.0 1-Jan-17 19:00 1.0

1-Jan-17 7:15 1.0 1-Jan-17 19:15 1.0

1-Jan-17 7:30 1.0 1-Jan-17 19:30 1.0

1-Jan-17 7:45 1.0 1-Jan-17 19:45 1.0

1-Jan-17 8:00 1.0 1-Jan-17 20:00 1.0

1-Jan-17 8:15 1.0 1-Jan-17 20:15 1.0

1-Jan-17 8:30 1.0 1-Jan-17 20:30 1.0

1-Jan-17 8:45 1.0 1-Jan-17 20:45 1.0

1-Jan-17 9:00 1.0 1-Jan-17 21:00 1.0

1-Jan-17 9:15 1.0 1-Jan-17 21:15 1.0

1-Jan-17 9:30 1.0 1-Jan-17 21:30 1.0

1-Jan-17 9:45 1.0 1-Jan-17 21:45 1.0

1-Jan-17 10:00 1.0 1-Jan-17 22:00 1.0

1-Jan-17 10:15 1.0 1-Jan-17 22:15 1.0

1-Jan-17 10:30 1.0 1-Jan-17 22:30 1.0

1-Jan-17 10:45 1.0 1-Jan-17 22:45 1.0

1-Jan-17 11:00 1.0 1-Jan-17 23:00 1.0

1-Jan-17 11:15 1.0 1-Jan-17 23:15 1.0

1-Jan-17 11:30 1.0 1-Jan-17 23:30 1.0

1-Jan-17 11:45 1.0 1-Jan-17 23:45 1.0

2-Jan-17 0:00 1.0
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APPENDIX B 

DISCHARGE DATA FOR 5 YEARS ARI 

 

Date Time Flowrate Date Time Flowrate Date Time Flowrate Date Time Flowrate

1-Jan-17 0:00 1.0 1-Jan-17 6:00 1.0 1-Jan-17 12:00 1.0 1-Jan-17 18:00 1.0

1-Jan-17 0:05 1.0 1-Jan-17 6:05 1.0 1-Jan-17 12:05 1.0 1-Jan-17 18:05 1.0

1-Jan-17 0:10 1.1 1-Jan-17 6:10 1.0 1-Jan-17 12:10 1.0 1-Jan-17 18:10 1.0

1-Jan-17 0:15 1.2 1-Jan-17 6:15 1.0 1-Jan-17 12:15 1.0 1-Jan-17 18:15 1.0

1-Jan-17 0:20 1.2 1-Jan-17 6:20 1.0 1-Jan-17 12:20 1.0 1-Jan-17 18:20 1.0

1-Jan-17 0:25 1.2 1-Jan-17 6:25 1.0 1-Jan-17 12:25 1.0 1-Jan-17 18:25 1.0

1-Jan-17 0:30 1.2 1-Jan-17 6:30 1.0 1-Jan-17 12:30 1.0 1-Jan-17 18:30 1.0

1-Jan-17 0:35 1.2 1-Jan-17 6:35 1.0 1-Jan-17 12:35 1.0 1-Jan-17 18:35 1.0

1-Jan-17 0:40 1.2 1-Jan-17 6:40 1.0 1-Jan-17 12:40 1.0 1-Jan-17 18:40 1.0

1-Jan-17 0:45 1.2 1-Jan-17 6:45 1.0 1-Jan-17 12:45 1.0 1-Jan-17 18:45 1.0

1-Jan-17 0:50 1.2 1-Jan-17 6:50 1.0 1-Jan-17 12:50 1.0 1-Jan-17 18:50 1.0

1-Jan-17 0:55 1.1 1-Jan-17 6:55 1.0 1-Jan-17 12:55 1.0 1-Jan-17 18:55 1.0

1-Jan-17 1:00 1.1 1-Jan-17 7:00 1.0 1-Jan-17 13:00 1.0 1-Jan-17 19:00 1.0

1-Jan-17 1:05 1.1 1-Jan-17 7:05 1.0 1-Jan-17 13:05 1.0 1-Jan-17 19:05 1.0

1-Jan-17 1:10 1.1 1-Jan-17 7:10 1.0 1-Jan-17 13:10 1.0 1-Jan-17 19:10 1.0

1-Jan-17 1:15 1.1 1-Jan-17 7:15 1.0 1-Jan-17 13:15 1.0 1-Jan-17 19:15 1.0

1-Jan-17 1:20 1.1 1-Jan-17 7:20 1.0 1-Jan-17 13:20 1.0 1-Jan-17 19:20 1.0

1-Jan-17 1:25 1.1 1-Jan-17 7:25 1.0 1-Jan-17 13:25 1.0 1-Jan-17 19:25 1.0

1-Jan-17 1:30 1.1 1-Jan-17 7:30 1.0 1-Jan-17 13:30 1.0 1-Jan-17 19:30 1.0

1-Jan-17 1:35 1.1 1-Jan-17 7:35 1.0 1-Jan-17 13:35 1.0 1-Jan-17 19:35 1.0

1-Jan-17 1:40 1.1 1-Jan-17 7:40 1.0 1-Jan-17 13:40 1.0 1-Jan-17 19:40 1.0

1-Jan-17 1:45 1.1 1-Jan-17 7:45 1.0 1-Jan-17 13:45 1.0 1-Jan-17 19:45 1.0

1-Jan-17 1:50 1.1 1-Jan-17 7:50 1.0 1-Jan-17 13:50 1.0 1-Jan-17 19:50 1.0

1-Jan-17 1:55 1.1 1-Jan-17 7:55 1.0 1-Jan-17 13:55 1.0 1-Jan-17 19:55 1.0

1-Jan-17 2:00 1.0 1-Jan-17 8:00 1.0 1-Jan-17 14:00 1.0 1-Jan-17 20:00 1.0

1-Jan-17 2:05 1.0 1-Jan-17 8:05 1.0 1-Jan-17 14:05 1.0 1-Jan-17 20:05 1.0

1-Jan-17 2:10 1.0 1-Jan-17 8:10 1.0 1-Jan-17 14:10 1.0 1-Jan-17 20:10 1.0

1-Jan-17 2:15 1.0 1-Jan-17 8:15 1.0 1-Jan-17 14:15 1.0 1-Jan-17 20:15 1.0

1-Jan-17 2:20 1.0 1-Jan-17 8:20 1.0 1-Jan-17 14:20 1.0 1-Jan-17 20:20 1.0

1-Jan-17 2:25 1.0 1-Jan-17 8:25 1.0 1-Jan-17 14:25 1.0 1-Jan-17 20:25 1.0

1-Jan-17 2:30 1.0 1-Jan-17 8:30 1.0 1-Jan-17 14:30 1.0 1-Jan-17 20:30 1.0

1-Jan-17 2:35 1.0 1-Jan-17 8:35 1.0 1-Jan-17 14:35 1.0 1-Jan-17 20:35 1.0

1-Jan-17 2:40 1.0 1-Jan-17 8:40 1.0 1-Jan-17 14:40 1.0 1-Jan-17 20:40 1.0

1-Jan-17 2:45 1.0 1-Jan-17 8:45 1.0 1-Jan-17 14:45 1.0 1-Jan-17 20:45 1.0

1-Jan-17 2:50 1.0 1-Jan-17 8:50 1.0 1-Jan-17 14:50 1.0 1-Jan-17 20:50 1.0

1-Jan-17 2:55 1.0 1-Jan-17 8:55 1.0 1-Jan-17 14:55 1.0 1-Jan-17 20:55 1.0

1-Jan-17 3:00 1.0 1-Jan-17 9:00 1.0 1-Jan-17 15:00 1.0 1-Jan-17 21:00 1.0

1-Jan-17 3:05 1.0 1-Jan-17 9:05 1.0 1-Jan-17 15:05 1.0 1-Jan-17 21:05 1.0

1-Jan-17 3:10 1.0 1-Jan-17 9:10 1.0 1-Jan-17 15:10 1.0 1-Jan-17 21:10 1.0

1-Jan-17 3:15 1.0 1-Jan-17 9:15 1.0 1-Jan-17 15:15 1.0 1-Jan-17 21:15 1.0

1-Jan-17 3:20 1.0 1-Jan-17 9:20 1.0 1-Jan-17 15:20 1.0 1-Jan-17 21:20 1.0

1-Jan-17 3:25 1.0 1-Jan-17 9:25 1.0 1-Jan-17 15:25 1.0 1-Jan-17 21:25 1.0

1-Jan-17 3:30 1.0 1-Jan-17 9:30 1.0 1-Jan-17 15:30 1.0 1-Jan-17 21:30 1.0

1-Jan-17 3:35 1.0 1-Jan-17 9:35 1.0 1-Jan-17 15:35 1.0 1-Jan-17 21:35 1.0

1-Jan-17 3:40 1.0 1-Jan-17 9:40 1.0 1-Jan-17 15:40 1.0 1-Jan-17 21:40 1.0

1-Jan-17 3:45 1.0 1-Jan-17 9:45 1.0 1-Jan-17 15:45 1.0 1-Jan-17 21:45 1.0

1-Jan-17 3:50 1.0 1-Jan-17 9:50 1.0 1-Jan-17 15:50 1.0 1-Jan-17 21:50 1.0

1-Jan-17 3:55 1.0 1-Jan-17 9:55 1.0 1-Jan-17 15:55 1.0 1-Jan-17 21:55 1.0

1-Jan-17 4:00 1.0 1-Jan-17 10:00 1.0 1-Jan-17 16:00 1.0 1-Jan-17 22:00 1.0

1-Jan-17 4:05 1.0 1-Jan-17 10:05 1.0 1-Jan-17 16:05 1.0 1-Jan-17 22:05 1.0

1-Jan-17 4:10 1.0 1-Jan-17 10:10 1.0 1-Jan-17 16:10 1.0 1-Jan-17 22:10 1.0

1-Jan-17 4:15 1.0 1-Jan-17 10:15 1.0 1-Jan-17 16:15 1.0 1-Jan-17 22:15 1.0

1-Jan-17 4:20 1.0 1-Jan-17 10:20 1.0 1-Jan-17 16:20 1.0 1-Jan-17 22:20 1.0

1-Jan-17 4:25 1.0 1-Jan-17 10:25 1.0 1-Jan-17 16:25 1.0 1-Jan-17 22:25 1.0

1-Jan-17 4:30 1.0 1-Jan-17 10:30 1.0 1-Jan-17 16:30 1.0 1-Jan-17 22:30 1.0

1-Jan-17 4:35 1.0 1-Jan-17 10:35 1.0 1-Jan-17 16:35 1.0 1-Jan-17 22:35 1.0

1-Jan-17 4:40 1.0 1-Jan-17 10:40 1.0 1-Jan-17 16:40 1.0 1-Jan-17 22:40 1.0

1-Jan-17 4:45 1.0 1-Jan-17 10:45 1.0 1-Jan-17 16:45 1.0 1-Jan-17 22:45 1.0

1-Jan-17 4:50 1.0 1-Jan-17 10:50 1.0 1-Jan-17 16:50 1.0 1-Jan-17 22:50 1.0

1-Jan-17 4:55 1.0 1-Jan-17 10:55 1.0 1-Jan-17 16:55 1.0 1-Jan-17 22:55 1.0

1-Jan-17 5:00 1.0 1-Jan-17 11:00 1.0 1-Jan-17 17:00 1.0 1-Jan-17 23:00 1.0

1-Jan-17 5:05 1.0 1-Jan-17 11:05 1.0 1-Jan-17 17:05 1.0 1-Jan-17 23:05 1.0

1-Jan-17 5:10 1.0 1-Jan-17 11:10 1.0 1-Jan-17 17:10 1.0 1-Jan-17 23:10 1.0

1-Jan-17 5:15 1.0 1-Jan-17 11:15 1.0 1-Jan-17 17:15 1.0 1-Jan-17 23:15 1.0

1-Jan-17 5:20 1.0 1-Jan-17 11:20 1.0 1-Jan-17 17:20 1.0 1-Jan-17 23:20 1.0

1-Jan-17 5:25 1.0 1-Jan-17 11:25 1.0 1-Jan-17 17:25 1.0 1-Jan-17 23:25 1.0

1-Jan-17 5:30 1.0 1-Jan-17 11:30 1.0 1-Jan-17 17:30 1.0 1-Jan-17 23:30 1.0

1-Jan-17 5:35 1.0 1-Jan-17 11:35 1.0 1-Jan-17 17:35 1.0 1-Jan-17 23:35 1.0

1-Jan-17 5:40 1.0 1-Jan-17 11:40 1.0 1-Jan-17 17:40 1.0 1-Jan-17 23:40 1.0

1-Jan-17 5:45 1.0 1-Jan-17 11:45 1.0 1-Jan-17 17:45 1.0 1-Jan-17 23:45 1.0

1-Jan-17 5:50 1.0 1-Jan-17 11:50 1.0 1-Jan-17 17:50 1.0 1-Jan-17 23:50 1.0

1-Jan-17 5:55 1.0 1-Jan-17 11:55 1.0 1-Jan-17 17:55 1.0 1-Jan-17 23:55 1.0
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APPENDIX C 

DISCHARGE DATA FOR 10 YEARS ARI 

 

Date Time Flowrate Date Time Flowrate Date Time Flowrate Date Time Flowrate

1-Feb-17 0:00 1.00 1-Feb-17 6:00 1.00 1-Feb-17 12:00 1.00 1-Feb-17 18:00 1.00

1-Feb-17 0:05 1.00 2-Feb-17 6:05 1.00 1-Feb-17 12:05 1.00 1-Feb-17 18:05 1.00

1-Feb-17 0:10 1.10 3-Feb-17 6:10 1.00 1-Feb-17 12:10 1.00 1-Feb-17 18:10 1.00

1-Feb-17 0:15 1.20 1-Feb-17 6:15 1.00 1-Feb-17 12:15 1.00 1-Feb-17 18:15 1.00

1-Feb-17 0:20 1.30 1-Feb-17 6:20 1.00 1-Feb-17 12:20 1.00 1-Feb-17 18:20 1.00

1-Feb-17 0:25 1.30 1-Feb-17 6:25 1.00 1-Feb-17 12:25 1.00 1-Feb-17 18:25 1.00

1-Feb-17 0:30 1.20 1-Feb-17 6:30 1.00 1-Feb-17 12:30 1.00 1-Feb-17 18:30 1.00

1-Feb-17 0:35 1.20 1-Feb-17 6:35 1.00 1-Feb-17 12:35 1.00 1-Feb-17 18:35 1.00

1-Feb-17 0:40 1.20 1-Feb-17 6:40 1.00 1-Feb-17 12:40 1.00 1-Feb-17 18:40 1.00

1-Feb-17 0:45 1.20 1-Feb-17 6:45 1.00 1-Feb-17 12:45 1.00 1-Feb-17 18:45 1.00

1-Feb-17 0:50 1.20 1-Feb-17 6:50 1.00 1-Feb-17 12:50 1.00 1-Feb-17 18:50 1.00

1-Feb-17 0:55 1.20 1-Feb-17 6:55 1.00 1-Feb-17 12:55 1.00 1-Feb-17 18:55 1.00

1-Feb-17 1:00 1.10 1-Feb-17 7:00 1.00 1-Feb-17 13:00 1.00 1-Feb-17 19:00 1.00

1-Feb-17 1:05 1.10 1-Feb-17 7:05 1.00 1-Feb-17 13:05 1.00 1-Feb-17 19:05 1.00

1-Feb-17 1:10 1.10 1-Feb-17 7:10 1.00 1-Feb-17 13:10 1.00 1-Feb-17 19:10 1.00

1-Feb-17 1:15 1.10 1-Feb-17 7:15 1.00 1-Feb-17 13:15 1.00 1-Feb-17 19:15 1.00

1-Feb-17 1:20 1.10 1-Feb-17 7:20 1.00 1-Feb-17 13:20 1.00 1-Feb-17 19:20 1.00

1-Feb-17 1:25 1.10 1-Feb-17 7:25 1.00 1-Feb-17 13:25 1.00 1-Feb-17 19:25 1.00

1-Feb-17 1:30 1.10 1-Feb-17 7:30 1.00 1-Feb-17 13:30 1.00 1-Feb-17 19:30 1.00

1-Feb-17 1:35 1.10 1-Feb-17 7:35 1.00 1-Feb-17 13:35 1.00 1-Feb-17 19:35 1.00

1-Feb-17 1:40 1.10 1-Feb-17 7:40 1.00 1-Feb-17 13:40 1.00 1-Feb-17 19:40 1.00

1-Feb-17 1:45 1.10 1-Feb-17 7:45 1.00 1-Feb-17 13:45 1.00 1-Feb-17 19:45 1.00

1-Feb-17 1:50 1.10 1-Feb-17 7:50 1.00 1-Feb-17 13:50 1.00 1-Feb-17 19:50 1.00

1-Feb-17 1:55 1.10 1-Feb-17 7:55 1.00 1-Feb-17 13:55 1.00 1-Feb-17 19:55 1.00

1-Feb-17 2:00 1.10 1-Feb-17 8:00 1.00 1-Feb-17 14:00 1.00 1-Feb-17 20:00 1.00

1-Feb-17 2:05 1.10 1-Feb-17 8:05 1.00 1-Feb-17 14:05 1.00 1-Feb-17 20:05 1.00

1-Feb-17 2:10 1.00 1-Feb-17 8:10 1.00 1-Feb-17 14:10 1.00 1-Feb-17 20:10 1.00

1-Feb-17 2:15 1.00 1-Feb-17 8:15 1.00 1-Feb-17 14:15 1.00 1-Feb-17 20:15 1.00

1-Feb-17 2:20 1.00 1-Feb-17 8:20 1.00 1-Feb-17 14:20 1.00 1-Feb-17 20:20 1.00

1-Feb-17 2:25 1.00 1-Feb-17 8:25 1.00 1-Feb-17 14:25 1.00 1-Feb-17 20:25 1.00

1-Feb-17 2:30 1.00 1-Feb-17 8:30 1.00 1-Feb-17 14:30 1.00 1-Feb-17 20:30 1.00

1-Feb-17 2:35 1.00 1-Feb-17 8:35 1.00 1-Feb-17 14:35 1.00 1-Feb-17 20:35 1.00

1-Feb-17 2:40 1.00 1-Feb-17 8:40 1.00 1-Feb-17 14:40 1.00 1-Feb-17 20:40 1.00

1-Feb-17 2:45 1.00 1-Feb-17 8:45 1.00 1-Feb-17 14:45 1.00 1-Feb-17 20:45 1.00

1-Feb-17 2:50 1.00 1-Feb-17 8:50 1.00 1-Feb-17 14:50 1.00 1-Feb-17 20:50 1.00

1-Feb-17 2:55 1.00 1-Feb-17 8:55 1.00 1-Feb-17 14:55 1.00 1-Feb-17 20:55 1.00

1-Feb-17 3:00 1.00 1-Feb-17 9:00 1.00 1-Feb-17 15:00 1.00 1-Feb-17 21:00 1.00

1-Feb-17 3:05 1.00 1-Feb-17 9:05 1.00 1-Feb-17 15:05 1.00 1-Feb-17 21:05 1.00

1-Feb-17 3:10 1.00 1-Feb-17 9:10 1.00 1-Feb-17 15:10 1.00 1-Feb-17 21:10 1.00

1-Feb-17 3:15 1.00 1-Feb-17 9:15 1.00 1-Feb-17 15:15 1.00 1-Feb-17 21:15 1.00

1-Feb-17 3:20 1.00 1-Feb-17 9:20 1.00 1-Feb-17 15:20 1.00 1-Feb-17 21:20 1.00

1-Feb-17 3:25 1.00 1-Feb-17 9:25 1.00 1-Feb-17 15:25 1.00 1-Feb-17 21:25 1.00

1-Feb-17 3:30 1.00 1-Feb-17 9:30 1.00 1-Feb-17 15:30 1.00 1-Feb-17 21:30 1.00

1-Feb-17 3:35 1.00 1-Feb-17 9:35 1.00 1-Feb-17 15:35 1.00 1-Feb-17 21:35 1.00

1-Feb-17 3:40 1.00 1-Feb-17 9:40 1.00 1-Feb-17 15:40 1.00 1-Feb-17 21:40 1.00

1-Feb-17 3:45 1.00 1-Feb-17 9:45 1.00 1-Feb-17 15:45 1.00 1-Feb-17 21:45 1.00

1-Feb-17 3:50 1.00 1-Feb-17 9:50 1.00 1-Feb-17 15:50 1.00 1-Feb-17 21:50 1.00

1-Feb-17 3:55 1.00 1-Feb-17 9:55 1.00 1-Feb-17 15:55 1.00 1-Feb-17 21:55 1.00

1-Feb-17 4:00 1.00 1-Feb-17 10:00 1.00 1-Feb-17 16:00 1.00 1-Feb-17 22:00 1.00

1-Feb-17 4:05 1.00 1-Feb-17 10:05 1.00 1-Feb-17 16:05 1.00 1-Feb-17 22:05 1.00

1-Feb-17 4:10 1.00 1-Feb-17 10:10 1.00 1-Feb-17 16:10 1.00 1-Feb-17 22:10 1.00

1-Feb-17 4:15 1.00 1-Feb-17 10:15 1.00 1-Feb-17 16:15 1.00 1-Feb-17 22:15 1.00

1-Feb-17 4:20 1.00 1-Feb-17 10:20 1.00 1-Feb-17 16:20 1.00 1-Feb-17 22:20 1.00

1-Feb-17 4:25 1.00 1-Feb-17 10:25 1.00 1-Feb-17 16:25 1.00 1-Feb-17 22:25 1.00

1-Feb-17 4:30 1.00 1-Feb-17 10:30 1.00 1-Feb-17 16:30 1.00 1-Feb-17 22:30 1.00

1-Feb-17 4:35 1.00 1-Feb-17 10:35 1.00 1-Feb-17 16:35 1.00 1-Feb-17 22:35 1.00

1-Feb-17 4:40 1.00 1-Feb-17 10:40 1.00 1-Feb-17 16:40 1.00 1-Feb-17 22:40 1.00

1-Feb-17 4:45 1.00 1-Feb-17 10:45 1.00 1-Feb-17 16:45 1.00 1-Feb-17 22:45 1.00

1-Feb-17 4:50 1.00 1-Feb-17 10:50 1.00 1-Feb-17 16:50 1.00 1-Feb-17 22:50 1.00

1-Feb-17 4:55 1.00 1-Feb-17 10:55 1.00 1-Feb-17 16:55 1.00 1-Feb-17 22:55 1.00

1-Feb-17 5:00 1.00 1-Feb-17 11:00 1.00 1-Feb-17 17:00 1.00 1-Feb-17 23:00 1.00

1-Feb-17 5:05 1.00 1-Feb-17 11:05 1.00 1-Feb-17 17:05 1.00 1-Feb-17 23:05 1.00

1-Feb-17 5:10 1.00 1-Feb-17 11:10 1.00 1-Feb-17 17:10 1.00 1-Feb-17 23:10 1.00

1-Feb-17 5:15 1.00 1-Feb-17 11:15 1.00 1-Feb-17 17:15 1.00 1-Feb-17 23:15 1.00

1-Feb-17 5:20 1.00 1-Feb-17 11:20 1.00 1-Feb-17 17:20 1.00 1-Feb-17 23:20 1.00

1-Feb-17 5:25 1.00 1-Feb-17 11:25 1.00 1-Feb-17 17:25 1.00 1-Feb-17 23:25 1.00

1-Feb-17 5:30 1.00 1-Feb-17 11:30 1.00 1-Feb-17 17:30 1.00 1-Feb-17 23:30 1.00

1-Feb-17 5:35 1.00 1-Feb-17 11:35 1.00 1-Feb-17 17:35 1.00 1-Feb-17 23:35 1.00

1-Feb-17 5:40 1.00 1-Feb-17 11:40 1.00 1-Feb-17 17:40 1.00 1-Feb-17 23:40 1.00

1-Feb-17 5:45 1.00 1-Feb-17 11:45 1.00 1-Feb-17 17:45 1.00 1-Feb-17 23:45 1.00

1-Feb-17 5:50 1.00 1-Feb-17 11:50 1.00 1-Feb-17 17:50 1.00 1-Feb-17 23:50 1.00

1-Feb-17 5:55 1.00 1-Feb-17 11:55 1.00 1-Feb-17 17:55 1.00 1-Feb-17 23:55 1.00

2-Feb-17 0:00 1.00
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